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STATEMENT OF PURPOSE

Kate L. Turabian’s A Manual for Writers of Term Papers, Theses, and Dissertations,
sixth edition (1996), is the recognized manual of style for classroom research pa-
pers and theses submitted at Luther Seminary. The purpose of The Shortcut is to
point out preferences adopted by Luther Seminary where Turabian gives options,
to provide clear and concise guidance for the front matter of theses, and to supply
information specific to theological research. Where there are divergences of inter-
pretation between Turabian and this manual, The Shortcut takes precedence. For
questions not addressed in Turabian or The Shortcut students may need to consult
The Chicago Manual of Style, fifteenth edition (2003). The SBL Handbook of Style
provides the standard for transliterating ancient languages, and abbreviations of
ancient texts and secondary sources.

Any questions concerning the interpretation of this manual or of graduate theses
in general should be addressed to the Director of Library Services or the Director of
Graduate Theological Education. We welcome your comments and any additions
that will help to improve future revisions of this manual.

Luther Seminary Library
Luther Seminary Graduate Theological Education

December 2005
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INTRODUCTION

How does one “follow” The Shortcut?

• Read The Shortcut to determine what stylistic matters apply in the initial
stages of researching, structuring, and composing the thesis or paper.
REMEMBER: If you put your material in proper stylistic form during the in-
formation gathering stage, you will save time at the writing stage.

• Use Turabian’s manual or The Chicago Manual of Style, 15th Edition
(2003), to advise further on points not covered in The Shortcut.

• Return to The Shortcut for a careful look at how the final product should
appear.

A thesis or research paper is made up of three major parts:
• the front matter
• the text
• the reference matter

Their arrangement, regardless of what sections may not be included, is as follows:

Ph.D. or D.Min. Thesis
(Numbers in parentheses refer to sections in Turabian)

THE FRONT MATTER, OR PRELIMINARIES (numbered with consecutive lowercase
roman numerals centered at the bottom of the page—exceptions noted)

Title page – include in page count but page number not typed; not listed in
table of contents (1.7)

Copyright page – not in page count, not listed in table of contents (1.8)

Approval Sheet (Ph.D.) – not in page count; not listed in table of contents.

Abstract

Acknowledgments (1.26)

Preface (1.25)

Table of Contents – in page count and page number typed; not listed in
table of contents (1.11–18)

List of Illustrations (1.19–23)

List of Tables (1.24)

List of Abbreviations (1.27)

Dedication – not in page count; not listed in table of contents (1.9)

Epigraph – not in page count; not listed in table of contents (1.10)

THE TEXT (consecutive arabic numerals in the upper right-hand corner, but cen-
tered at the bottom on the first page of each chapter)

Introduction (1.34)

Body with footnotes at the bottom of the page (1.36)

Separate title pages for Part I, Part II, etc. – in page count but page number
not typed; listed in table of contents (1.35)

THE REFERENCE MATTER OR BACK MATTER (arabic numerals continued)
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Appendix(es) – with page numbers at the bottom of the first page of
an appendix like the first page of a chapter (1.39–45)

Glossary (1.28–30)

Bibliography (1.47)

M.A. or M.Th. Thesis
(Numbers in parentheses refer to sections in Turabian)

THE FRONT MATTER, OR PRELIMINARIES (numbered with consecutive lowercase
roman numerals centered at the bottom of the page—exceptions noted)

Title page – include in page count but page number not typed; not listed
in table of contents (1.7)

Blank page – not in page count, not listed in table of contents (1.8)

Acknowledgments (1.26)

Preface (1.25)

Table of Contents – in page count and page number typed; not listed in
table of contents (1.11–18)

List of Illustrations (1.19–23)

List of Tables (1.24)

List of Abbreviations (1.27)

Dedication – not in page count; not listed in table of contents (1.9)

Epigraph – not in page count; not listed in table of contents (1.10)

THE TEXT (consecutive arabic numerals in the upper right-hand corner, but cen-
tered at the bottom on the first page of each chapter)

Introduction (1.34)

Body with footnotes at the bottom of the page (1.36)

Separate title pages for Part I, Part II, etc. – in page count but page number
not typed; listed in table of contents (1.35)

THE REFERENCE MATTER OR BACK MATTER (arabic numerals continued)

Appendix(es) – with page numbers at the bottom of the first page of an
appendix like the first page of a chapter (1.39–45)

Glossary (1.28–30)

Bibliography (1.47)

Research paper
(Numbers in parentheses refer to sections in Turabian)

THE FRONT MATTER
Title page – include in page count but page number not typed (1.7)

THE TEXT (consecutive arabic numerals in the upper right-hand corner, but cen-
tered at the bottom on the first page)

THE REFERENCE MATTER OR BACK MATTER (arabic numerals continued)
Appendix(es) (1.39–45)
Bibliography (1.47)
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THE LETTER AND THE SPIRIT:

A HISTORY OF INTERPRETATION FROM

ORIGEN TO LUTHER

by

WAI-SHING CHAU

A Thesis Submitted to the Faculty of

Luther Seminary

In Partial Fulfillment of

The Requirements for the Degree of

DOCTOR OF PHILOSOPHY

ST. PAUL, MINNESOTA

1990
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[Ph.D. Thesis Title Page]
[Please note: Center from
margins and not
from edges of page]

� [6-8 single lines]

� [5 single lines]

� [8-10 single lines]



PREACHING LAW/GOSPEL THEOLOGY

IN A POSTMODERN WORLD

by

NATHAN SAGER

A Thesis Submitted to the Faculty of

Luther Seminary

In Partial Fulfillment of

The Requirements for the Degree of

DOCTOR OF MINISTRY

ST. PAUL, MINNESOTA

1999
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1.5" 1"

2"

1"

[D.Min. Thesis Project Title Page]
[Please note: Center from
margins and not
from edges of page]

� [6-8 single lines]

� [5 single lines]

� [8-10 single lines]



THE CRUCIFIED MESSIAH?

THE CRISIS OF IDENTITY REGARDING JESUS OF NAZARETH:

A STUDY OF THE ROYAL MESSIANIC IMAGERY IN MARK’S GOSPEL

by

THOMAS A. REINER, JR.

A Thesis Submitted to the Faculty of

Luther Seminary

In Partial Fulfillment of

The Requirements for the Degree of

MASTER OF THEOLOGY [or] ARTS

THESIS ADVISER: DONALD JUEL

ST. PAUL, MINNESOTA

1982
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[M.Th. or M.A. Thesis Title Page]
[Please note: Center from
margins and not
from edges of page]

� [6-8 single lines]

� [4 single lines]

[Type one of the following:]
This thesis may be duplicated.

This thesis may not be duplicated.

This thesis may be duplicated only by special permission of the author.

� [4 single lines]

� [4 single lines]



The Crucified Messiah?

The Crisis of Identity regarding Jesus of Nazareth:

A Study of the Royal Messianic Imagery in Mark’s Gospel

by

Thomas A. Reiner, Jr.

A Term Paper

Presented to Professor David Fredrickson

Luther Seminary

As a Requirement in

Course A287

Seminar in

New Testament Christology

St. Paul, Minnesota

1995
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[Classroom Research Paper Title Page]
[Please note: Center from
margins and not
from edges of page]

� [5-8 single lines]

� [5 single lines]

� [3 single lines]

� [5 single lines]



© 1990 by Wai-shing Chau

All rights reserved

9

1.5" 1"

[The Ph.D. thesis and the D.Min. thesis project include the
copyright statement. Please note: Center from margins and not
from edges of page]



LUTHER SEMINARY

ST. PAUL, MINNESOTA

PH.D. THESIS

Title of Thesis: The Letter and the Spirit: A History of Interpretation
from Origen to Luther

Author: Wai-shing Chau

Thesis committee: _____________________________________ _______________
Thesis Adviser Date

_____________________________________ _______________

_____________________________________ _______________

[type additional lines if more readers]
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ABSTRACT

The Tabernacle in the New Testament and
Intertestamental Jewish Literature

by

Craig Richard Koester

This study explores the significance of the Israelite tabernacle in the NT. The first

section surveys references to the tabernacle in the OT and intertestamental Jewish

literature. The remaining chapters discuss NT references to the tabernacle in their present

context and investigate possible antecedents for NT views of the tabernacle.

The author of Stephen’s speech (Acts 7) perceived the tabernacle as a form of

worship that was mandated by the law and established by a prophet; he rejected the

temple because it met neither criterion. He also viewed the tabernacle as God’s response

to Israel’s apostasy. Antecedents for his views appear in 1 Enoch’s “Dream Vision” and

the Testament of Moses.

John 1:14 uses the verb “to tabernacle” in a word play that alludes to the Israelite

tabernacle and to the tabernacle of the human body. The tabernacle imagery introduces

the believing community’s testimony to Jesus, and may reflect both continuity and

discontinuity with Israel’s past, unity between Christians of Jewish and Samaritan origin,

and the Johannine community’s separation from first-century cultic institutions.

Antecedents for the imagery appear in wisdom traditions and perhaps the hidden

tabernacle tradition.

In Revelation, the most important use of tabernacle imagery is for the new

Jerusalem (21:3). The tabernacle-city is the church in the new age. Antecedents for the

imagery appear in OT passages, a liturgical tradition like that found in 4QDibHam, and a

non-Pauline fragment preserved in 2 Cor 6:14–7:1.
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The author of Hebrews interpreted the tabernacle temporally and spatially. He

identified the earthly tabernacle or its forecourt with earth, the present age, daily priestly

ministry, the realm of the flesh, and Mosaic regulations. He equated the heavenly

tabernacle or holy of holies with the age to come, high priestly ministry, and the realm of

conscience. Christ’s ministry occurs in heaven and has inaugurated a new age in which

observance of Mosaic statutes is no longer necessary. The argument presupposes the

cosmological interpretation of the tabernacle and wisdom traditions, and may reflect

knowledge of traditions about the hidden tabernacle and the tabernacle’s eternal

consecration.

[Abstract used by permission of the author.]
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Ph.D. abstracts should not exceed 350 words; D.Min. abstracts should not ex-
ceed 100 words.

UMI Dissertation Services gives the following abstract composition guidelines in
“Preparing Your Abstract,” found in the booklet Publishing Your Dissertation: How
to Prepare Your Manuscript for Publication:

Because your abstract will be used by researchers to determine whether or not they
wish to access your complete dissertation, it should provide a succinct, descriptive
account of your work. And since it will also appear online, it must not exceed 350
words. (Abstracts exceeding 350 words are returned to the author for condensing.)
Your abstract should be prepared carefully, since it will be published exactly as you
submit it. Please follow these guidelines:

Type or print out on one side of the paper only, double-spaced.

Include all pertinent place names and other proper nouns. These are
very useful in automated retrieval.

Display symbols, as well as foreign words and phrases, clearly and accurately.

Do not include graphs, charts, tables, or illustrations in your abstract.

Current abstracting practice is to use more compression than this example used.
Religious and Theological Abstracts urges abstractors “not [to] waste words saying
what the author is going to do.” Phrases such as “the aim of this study is” or “this
thesis is about” should be avoided, even if what results is a sentence fragment. The
first paragraph of the sample abstract edited with current abstracting style would
read:

Explores the significance of the Israelite temple in the NT. Surveys references to the
tabernacle in the OT and intertestamental Jewish literature. Discusses NT references
to the tabernacle in their present context and investigates possible antecedents for
NT views of the tabernacle.
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CHAPTER 1

THE TITLE OF THE CHAPTER APPEARS HERE

Typing begins ½" (.5) from the left-hand margin, which is the default tab setting

in Word. The chapter is a major section of the text of a research paper. Further division of

chapters is shown on this page. See Turabian 1.36 on levels of subheadings.

First-Level Subheading: Bold and Centered

The first-level subheading of the chapter is indicated by a bold centered heading.

Second-Level Subheading: Regular Font and Centered

The second-level subheading of the chapter is indicated by a centered heading.

Third-Level Subheading: Bold and Freestanding

The third-level subheading of the chapter is indicated by a bold freestanding

sideheading.

Fourth-level subheading: Regular font and freestanding

The fourth-level subheading of the chapter is indicated by a freestanding

sideheading. Note: The first three subheadings use headline-style capitalization; the

fourth uses sentence-style capitalization (T 1.37).
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� [Triple line space = two blank lines]

� [Triple line space]

� [Triple line space]

� [Triple line space]

� [Triple line space]

1.5" 1"

[Body of the Paper]
2"

1"

1[The page number on the beginning
page of a chapter is centered, and
within the 1" bottom margin.]



The second page of the chapter is numbered in the upper right-hand corner. [See

the Shortcut Appendix for instructions on how to make the change in page numbers.]

Prose quotations that exceed three lines of text should be placed in a block. See

Turabian 5.4 and 5.30-34 for a discussion of block quotations. Block quotations should

be set off from the rest of the text as follows:

Indent the entire block quotation ½ inch from the left margin. Ellipsis points (. . .)
are used to indicate the omission of any words or phrases. . . . See Turabian
5.18-30 for the use of ellipses in quotations and the capitalization of first word of
a quotation (5.26).

When a block quotation begins with a new paragraph, hit the spacebar three
times after the indentation of ½ inch. All quotation, whether in a block or in text,
MUST follow the exact wording, spelling, capitalization, and spelling of the
original. See Turabian 5.35-37 for the proper way to add interpolations to a
quotation.

Footnotes and Bibliography

• The use of footnotes at the bottom of the page is the preferred method of citation
for theses at Luther Seminary. In course work, endnotes following a paper may
be an option, at the direction of the instructor.

• See Turabian 14.35–36 for a sample of properly formatted text with footnotes.

• Footnotes should be separated from the text on a page by short rule or separator.

• A footnote must begin on the page where it is referenced, although it may
continue on to the following page.

• Footnotes have the first line indented ½ inch, are single-spaced, and have a
blank line between them. [See the Shortcut Appendix for instructions.]

• The footnote number can be followed by the footnote text without a space in
between, or there can be a space after the number (which is the Microsoft Word
default setting).

• The page numbering style and margin settings remain the same in the footnotes
as those in the text. The notes may be in 12 or 10 point font.

• Footnote numbers must follow one another in numerical order, beginning with
1. Numbering starts over at the beginning of each chapter.

• A first reference of a source in a footnote must be a full entry; subsequent entries
are shortened. See Turabian 8.90 for the preferred forms of shortened entries.

• All information in the first reference of a footnote (author’s name, title, editor,
publication information, etc.) should be identical with the information in the
bibliographic entry.

17
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• Turabian gives detailed guidance in citation rules for notes (chapter 9) and
presents samples of notes compared with their bibliographic entries (chapter
11).

Bibliography
• A bibliography should list in alphabetical sequence all the sources consulted in

writing the thesis.

• Bibliographies may be classified; in fact, this method is recommended if the
number or variety of sources is extensive. Thesis writers should consult their
advisors for guidance on what categories to use when classifying the
bibliography.

• The page number style and margin settings follow the standards in the text; the
top margin of the first page of the bibliography is 2"; the page number on the first
page is centered and at the bottom. All subsequent page numbers are at the
upper right-hand corner.

• Bibliographic entries should not be split between two pages.

• Turabian gives detailed guidance in citation rules for bibliographies (chapter 10)
and presents samples of notes compared with their bibliographic entries (chapter
11).

Basic Citation Forms
(Indentation: ½")

A. Book - Note
1Author’s full name in regular order, Title of Book, editor, translator, series,

edition, no. of vols. (Place: Publisher, Date), volume and pages both cited in arabic
numerals.

B. Book - Bibliography
Author’s full name with surname first. Title of Book. Editor. Translator. Series.

Edition. No. of vols. if more than one. Place of publication: Publisher, Date.

C. Journal - Note
1Author’s full name in regular order, “Title of Article,” Name of Journal vol-

ume in arabic numerals (Date of issue): pages cited. Neither issue numbers nor
season/months are needed if a journal is consecutively paginated throughout a vol-
ume. If the journal is not consecutively paginated the issue number should be in-
cluded. If an issue number does not exist, the season, month, or date should
precede the year of publication.

D. Journal - Bibliography
Author’s full name with surname first. “Title of Article.” Name of Journal volume

in arabic numerals (Date of issue) beginning and ending pages of article.
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SOCIETY OF BIBLICAL LITERATURE STANDARDS FOR CITATIONS

Consult The SBL Handbook of Style for guidelines on the following:
• transliteration of Hebrew and Greek (SBL 5.1 and 5.3)

• abbreviations for biblical books, apocrypha, and other ancient texts (SBL 8.3)

• abbreviations for Greek and Latin classics/works (SBL 8.3.14 and Appendix H)

• abbreviations of commonly used periodicals, reference works, and serials (SBL
8.4). If you do not locate the desired abbreviations, then use S. Schwertner,
International Glossary of Abbreviations for Theology and Related Subjects
(=IATG), Berlin and New York: Walter de Gruyter, 1974 (Z6945.S35). Copies
of IATG and SBL are at the Library Circulation Desk.

For guidelines for citing Greek and Latin classics/works, see Turabian 2.22;
8.119–127 and Chicago Manual of Style 17.250–259, and for medieval works, see
Turabian 8.128 and Chicago Manual of Style 17.260.

STANDARDS FOR THE ABBREVIATION OF LUTHER’S WORKS
AND THE LUTHERAN CONFESSIONAL WRITINGS

The following list has been developed as the desired form of abbreviation at Luther
Seminary when referring to material in the standard editions of Luther’s works and
the Lutheran confessions. A brief bibliographical description is sufficient for the
List of Abbreviations, but should include enough information to make clear from
what the abbreviation derives. The bibliography must include the full citation with
no abbreviations. Full bibliographic entries for all the editions of Luther’s works are
given under the section LUTHER’S WRITINGS (p. 33).
Note that these abbreviations in the footnotes are sufficient and need not be
spelled out the first time a term appears, contrary to T 1.27.

LUTHER

LW Luther’s Works. Edited by Jaroslav Pelikan and Helmut T. Lehmann.
56 vols. St. Louis and Philadelphia, 1955-86.

PE Works of Martin Luther. Philadelphia Edition. 6 vols. Philadelphia,
1915-43.

StL Johann Georg Walch, ed. Dr. Martin Luthers saemmtliche Schriften. 23
vols. St. Louis, 1880-1910.

WA D. Martin Luthers Werke. Kritische Gesamtausgabe (Weimarer
Ausgabe). Weimar, 1883-.

WA,Br D. Martin Luthers Werke. Kritische Gesamtausgabe. Briefwechsel. 18
vols. Weimar, 1930-85.

WA,DB D. Martin Luthers Werke. Kritische Gesamtausgabe. Die Deutsche
Bibel. 12 vols. Weimar, 1906-61.
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WA,TR D. Martin Luthers Werke. Kritische Gesamtausgabe. Tischreden. 6
vols. Weimar, 1912-21.

When referring to the above works, follow the abbreviation with the volume
number and/or part, if applicable. References to specific works of Luther, followed
by their date of composition (in parentheses), should also be included in the note.
Citing a treatise by Luther should appear thus:

1The Freedom of a Christian (1520), LW 31:343.

A colon separates the volume from the page designation. A slash separates the vol-
ume from the part, which is expressed in arabic numerals. Thus:

2Ein Missive allen denen, so von wegen des Wortes Gottes
Verfolgung leiden... (1522), WA 10/2:53.

See Kurt Aland, Hilfsbuch zum Lutherstudium, (4th ed., 1996), for an alphabetical
and chronological list of Luther’s writings in addition to keys to the contents of the
major editions of his works.

THE CONFESSIONAL WRITINGS

AC Augsburg Confession

Ap Apology of the Augsburg Confession

BC The Book of Concord. Edited by Robert Kolb and Timothy J. Wengert.
Minneapolis, 2000.

BSLK Die Bekenntnisschriften der evangelisch-lutherischen Kirche. Göttingen,
1930 [and subsequent editions]

FC Formula of Concord

FC,Ep Epitome of the Formula of Concord

FC,SD Solid Declaration of the Formula of Concord

LC Large Catechism

SA Smalcald Articles

SC Small Catechism

TPP Treatise on the Power and Primacy of the Pope

The Book of Concord, edited by Kolb and Wengert (2000), is the standard English
edition of the confessional writings. Use the marginal numbering in Kolb and
Wengert and the page number for references based on the English text. A citation
to the Augsburg Confession, for example, should change the traditional roman
numbering to arabic for the article divisions. Thus:

3AC,Ger. 15:2, in BC, 48. [include the abbreviation Ger. or Lat.
for the version of the Augsburg Confession being cited]
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Similarly, a reference to the Smalcald Articles, a work written with both part and
article divisions, should be cited:

4SA 3, 15:3, in BC, 326. [Part 3, Article 15, marginal number 3]

5SC Pref. 7, in BC, 348. [Preface to the SC, marginal number 7]

NOTE AND BIBLIOGRAPHY EXAMPLES

KEY: The numbers following the headings refer to the Turabian sections. Refer-
ences to the SBL sections or Chicago Manual of Style are identified as such. If no
examples are given under the heading, use the Turabian discussion as your guide.
“N.” = NOTE format; “B.” = BIBLIOGRAPHY format.
The footnote number can be followed by the footnote text without a space in
between, or there can be a space after the number (which is the Microsoft Word
default setting).

>>> BOOK WITH SINGLE AUTHOR — 11.3

N. 1W. D. Davies, Paul and Rabbinic Judaism: Some Rabbinic
Elements in Pauline Theology (London: S. P. C. K., 1977), 276-84.

B. Davies, W. D. Paul and Rabbinic Judaism: Some Rabbinic Elements in
Pauline Theology. London: S. P. C. K., 1977.

N. 2Barnabas Lindars, New Testament Apologetic: The Doctrinal
Significance of the Old Testament Quotations (Philadelphia: Westminster
Press, 1961), 77, 80.

N. 3Lindars, Apologetic, 85. [a subsequent reference not immediately
following first occurrence]

B. Lindars, Barnabas. New Testament Apologetic: The Doctrinal
Significance of the Old Testament Quotations. Philadelphia:
Westminster Press, 1961.

N. 4For an extensive bibliography on the subject of the Suffering
Servant, see Morna D. Hooker, Jesus and the Servant: The Influence of
the Servant Concept of Deutero-Isaiah in the New Testament (London:
S. P. C. K., 1959), 201-10. [a content note]

B. Hooker, Morna D. Jesus and the Servant: The Influence of the Servant
Concept of Deutero-Isaiah in the New Testament. London:
S. P. C. K., 1959.

N. 5Ernst Haenchen, Der Weg Jesu: Eine Erklärung des
Markus-Evangeliums und der kanonischen Parallelen (Berlin: Alfred
Töpelmann, 1966), 34.
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B. Haenchen, Ernst. Der Weg Jesu: Eine Erklärung des Markus-Evangeliums
und der kanonischen Parallelen. Berlin: Alfred Töpelmann, 1966.

>>> BOOKS WITH MORE THAN ONE AUTHOR —> SEE 11.4-6

N. 6Eric W. Gritsch and Robert W. Jenson, Lutheranism: The
Theological Movement and Its Confessional Writings (Philadelphia:
Fortress Press, 1976), 47.

B. Gritsch, Eric W., and Robert W. Jenson. Lutheranism: The Theological
Movement and Its Confessional Writings. Philadelphia: Fortress
Press, 1976.

Books with more than three (3) authors list only the first author followed by “et al.”

>>> BOOK WITH INSTITUTION, ASSOCIATION, OR LIKE, AS
“AUTHOR” – 11.10

N. 7Inter-Lutheran Commission on Worship, Lutheran Book of
Worship (Minneapolis: Augsburg Publishing House; Philadelphia: Board
of Publication, Lutheran Church in America, 1978), 201.

B. Inter-Lutheran Commission on Worship. Lutheran Book of Worship.
Minneapolis: Augsburg Publishing House; Philadelphia: Board of
Publication, Lutheran Church in America, 1978.

>>> AUTHOR’S WORK TRANSLATED OR EDITED BY ANOTHER —
11.12

N. 8Paul Ricoeur, Essays on Biblical Interpretation, ed. Lewis S.
Mudge (Philadelphia: Fortress Press, 1980), 13.

B. Ricoeur, Paul. Essays on Biblical Interpretation. Edited by Lewis S.
Mudge. Philadelphia: Fortress Press, 1980.

N. 9Helmut Thielicke, How the World Began: Man in the First
Chapters of the Bible, trans. John W. Doberstein (Philadelphia:
Muhlenberg Press, 1961), 133.

B. Thielicke, Helmut. How the World Began: Man in the First Chapters of
the Bible. Translated by John W. Doberstein. Philadelphia:
Muhlenberg Press, 1961.
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>>> BOOKS IN MULTIVOLUME OR COLLECTED WORKS — 11.13-15;
8.74-83

N. 10George Foot Moore, Judaism in the First Centuries of the
Christian Era: The Age of the Tannaim, 3 vols. (Cambridge: Harvard
University Press, 1927-30). [see 8.74 on reference to multivolume work
as a whole]

B. Moore, George Foot. Judaism in the First Centuries of the Christian Era:
The Age of the Tannaim. 3 vols. Cambridge: Harvard University
Press, 1927-30.

N. 11Paul Tillich, Systematic Theology, vol. 2 (Chicago: University of
Chicago Press, 1957). [see 8.78 on reference to specific volume as a
whole]

B. Tillich, Paul. Systematic Theology. Vol. 2. Chicago: University of
Chicago Press, 1957.

N. 12Paul Tillich, Systematic Theology, 3 vols. (Chicago: University
of Chicago Press, 1957), 2:123. [reference to page(s) in a volume of a set]

B. Tillich, Paul. Systematic Theology. Vol. 2. Chicago: University of
Chicago Press, 1957. [only this volume was used in the paper]

N. 13Jaroslav Pelikan, Reformation of Church and Dogma
(1300-1700), vol. 4 of The Christian Tradition: A History of the
Development of Doctrine (Chicago: University of Chicago Press, 1984),
1-9. [a volume in a multivolume work with a title different than the
main work]

B. Pelikan, Jaroslav. Reformation of Church and Dogma (1300-1700). Vol. 4
of The Christian Tradition: A History of the Development of
Doctrine. Chicago: University of Chicago Press, 1984.

>>> BOOK IN A SERIES — 11.16

N. 14Donald H. Juel, Messiah and Temple: The Trial of Jesus in the
Gospel of Mark, SBLDS 31 (Missoula, MT: Scholars Press, 1977), 115.

B. Juel, Donald H. Messiah and Temple: The Trial of Jesus in the Gospel of
Mark. Society of Biblical Literature Dissertation Series 31.
Missoula, MT: Scholars Press, 1977. [note the preference for
standard series abbreviations in the note but spelled out in the
bibliography]
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>>> BOOK EDITION OTHER THAN FIRST — 11.18

N. 15J. Louis Martyn, History and Theology in the Fourth Gospel, 2d
ed., rev. and enl. (Nashville: Abingdon Press, 1976), 123-24.

B. Martyn, J. Louis. History and Theology in the Fourth Gospel, 2d ed., rev.
and enl. Nashville: Abingdon Press, 1976.

N. 16Vincent Taylor, The Gospel according to St. Mark, 2d ed.
(London: Macmillan Press, 1966), 378.

B. Taylor, Vincent. The Gospel according to St. Mark, 2d ed. London:
Macmillan Press, 1966.

>>> COMPONENT PART BY ONE AUTHOR IN A WORK BY ANOTHER
– 11.26

N. 17Nils Alstrup Dahl, “The Atonement—An Adequate Reward for
the Akedah? (Ro 8:32),” in Neotestamentica et Semitica, ed. E. Earle Ellis
and Max Wilcox (Edinburgh: T. & T. Clark, 1969), 15. [note Epistle to
the Romans abbreviation remains as spelled on title page]

B. Dahl, Nils Alstrup. “The Atonement—An Adequate Reward for the
Akedah? (Ro 8:32).” In Neotestamentica et Semitica, ed. E. Earle
Ellis and Max Wilcox, 15-27. Edinburgh: T. & T. Clark, 1969.

>>> COMPONENT PART OF A MULTIVOLUME WORK
AND

>>> SIGNED ARTICLE IN AN ENCYCLOPEDIA — 11.43; 8.74-83

N. 18George B. Caird, “Chronology of the NT,” in The Interpreter’s
Dictionary of the Bible, ed. George A. Buttrick (New York: Abingdon
Press, 1962), 1:601.

[or]

N. 18George B. Caird, “Chronology of the NT,” IDB 1:601.

B. Caird, George B. “Chronology of the NT.” In The Interpreter’s
Dictionary of the Bible, ed. George A. Buttrick, 1:599-607. New
York: Abingdon Press, 1962.

N. 19Terence E. Fretheim, “Elohist,” in The Interpreter’s Dictionary
of the Bible: Supplementary Volume, ed. Keith R. Crim (Nashville:
Abingdon, 1976), 261.

[or]

N. 19Terence E. Fretheim, “Elohist,” IDBSup 261.

B. Fretheim, Terence E. “Elohist.” In The Interpreter’s Dictionary of the
Bible: Supplementary Volume, ed. Keith R. Crim, 259-63.
Nashville: Abingdon, 1976.
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N. 20G. Quispel, “Pistis Sophia,” in Die Religion in Geschichte und
Gegenwart: Handwörterbuch für Theologie und Religionswissenschaft,
3d ed., ed. Hans Frhr. v. Campenhausen and others (Tübingen: J. C. B.
Mohr [Paul Siebeck], 1958), 5:387.

[or]

N. 20G. Quispel, “Pistis Sophia,” RGG3 5:387.

B. Quispel, G. “Pistis Sophia.” In Die Religion in Geschichte und
Gegenwart: Handwörterbuch für Theologie und
Religionswissenschaft, 3d ed., ed. Hans Frhr. v. Campenhausen
and others, 5:386-88. Tübingen: J. C. B. Mohr (Paul Siebeck),
1958.

N. 21Hermann Sasse, “aion, aionios,” in Theological Dictionary of the
New Testament, ed. G. Kittel and G. Friedrich, trans. and ed. Geoffrey
W. Bromiley (Grand Rapids, MI: Eerdmans, 1964), 1:199.

[or]

N. 21Hermann Sasse, “aion, aionios,” TDNT 1:199.

B. Sasse, Hermann. “aion, aionios.” In Theological Dictionary of the New
Testament, ed. G. Kittel and G. Friedrich, trans. and ed. Geoffrey
W. Bromiley, 1:197-209. Grand Rapids, MI: Eerdmans, 1964.

N. 22Gary Porton, “Midrash: Palestinian Jews and the Hebrew Bible
in the Greco-Roman Period,” in Aufstieg und Niedergang der römischen
Welt: Geschichte und Kultur Roms in Spiegel der neueren Forschung, ed.
Hildegard Temporini and Wolfgang Haase (New York: Walter de
Gruyter, 1979), 2,19,2:126.

[or]

N. 22Gary Porton, “Midrash: Palestinian Jews and the Hebrew Bible
in the Greco-Roman Period,” ANRW 2,19,2:126.

B. Porton, Gary. “Midrash: Palestinian Jews and the Hebrew Bible in the
Greco-Roman Period.” In Aufstieg und Niedergang der römischen
Welt: Geschichte und Kultur Roms in Spiegel der neueren
Forschung, ed. Hildegard Temporini and Wolfgang Haase,
2,19,2:103-38. New York: Walter de Gruyter, 1979.

>>> ARTICLE IN A JOURNAL — 11.39-11.40; 8.99-103

N. 23Robert C. Tannehill, “The Disciples in Mark: The Function of a
Narrative Role,” JR 57 (1977): 386.

B. Tannehill, Robert C. “The Disciples in Mark: The Function of a
Narrative Role.” The Journal of Religion 57 (1977): 386-405.
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>>> ARTICLE IN A MAGAZINE — 11.41; 8.104

N. 24James W. Reapsome, “God’s Calling Card: Sometimes Flashy,
Sometimes Not,” ChrTo, 18 September 1981, 30.

B. Reapsome, James W. “God’s Calling Card: Sometimes Flashy,
Sometimes Not.” Christianity Today, 18 September 1981, 30-31.

>>> ARTICLE IN A NEWSPAPER — SEE 11.44-45; 8.105-110

Since The Shortcut requires a bibliographic entry for every footnote, references
should include the name of the author, if given, and the title, as shown in 8.105.

>>> BOOK REVIEW IN A JOURNAL — 11.46

N. 25John C. Cavadini, review of Adam, Eve, and the Serpent, by
Elaine Pagels, The Thomist 53 (July 1989): 510.

B. Cavadini, John C. Review of Adam, Eve, and the Serpent, by Elaine
Pagels. The Thomist 53 (July 1989): 509-12.

>>> THESIS OR DISSERTATION — 11.55

N. 26Beverly J. Stratton, “Out of the Garden: A Feminist, Theological
Study of Reading, Rhetoric, and Ideology in Genesis 2-3” (Th.D. diss.,
Luther Seminary, 1994), 25.

B. Stratton, Beverly J. “Out of the Garden: A Feminist, Theological Study of
Reading, Rhetoric, and Ideology in Genesis 2-3.” Th.D. Diss.,
Luther Seminary, 1994.

>>> ELECTRONIC CITATIONS

The World Wide Web has become a major source of information in the twenty-first
century. The Chicago Manual of Style, 15th edition (CMOS), attempts to address
the growing use of online sources in academic work and offers these caveats when
using online citations:

Permanence (17.5): “electronic content by its very nature will continue to be
impermanent and manipulable.… Authors … should therefore verify the accuracy
of citations to electronic content as close to the publication date as possible.”

Authority (17.6): “As for any other medium, authors should consider the publisher
or sponsoring body when assessing electronic content. Content presented without
formal ties to a publisher or sponsoring body has authority equivalent to that of
unpublished or self-published material in other media.”

Because of these two issues, the lack of permanence of such sources, and the
questionable authority of much material available on the Internet, Luther Semi-
nary encourages careful judgement in the use of electronic sources, especially self-
published materials. Students should favor the print format over the electronic, if
available, and use Internet resources with discrimination.
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Proper forms for electronic citations, especially informally published materials, are
still in a state of flux, but a few general guidelines are clear:

• URL alone is insufficient as a citation. CMOS states: “If only a URL is cited and
that URL changes or becomes obsolete, the citation will have become just a more
or less unintelligible string of characters....A complete citation must also
indicate what a source is” (17.235).

• CMOS states that for informally published materials “include as much of the
following as can be determined: author of the content, title of the page, title or
owner of the site, URL” (17.237). The information should be listed in that order
in the note and bibliographic entry.

• If no individual author can be determined, the owner of the site should be listed
as author (CMOS 17.47 and 17.237).

• To determine the owner of the site, the researcher may need to surf the site for
that particular information. Clicking on “Home” button on a given page is one
fairly reliable way to access information about the owner of the site. This
information might be considered comparable to searching for the publication
information of a book; one must go to the front of the book or, in this case, the
“front” of the web site in order to find information about the publisher or
sponsor of the web site.

• CMOS offers these guides to break a URL at the end of a line: “the break should
be made after a double slash (//) or a single slash (/); before a tilde (~), a period, a
comma, a hyphen, an underline (_), a question mark, a number sign, or a percent
symbol; or before or after an equals sign or an ampersand [&]. A hyphen should
never be added to a URL to denote a line break, nor should a hyphen that is part
of a URL appear at the end of a line” (17.11).

• Luther Seminary requires the access date at the end of each online reference,
and strongly recommends students keep a printed copy of all materials cited
from the Internet.

• URLs should be cut and pasted into documents to ensure their reliability; in
notes and bibliographic references the hyperlink must be removed and text
formatted in 12 point font for bibliography and correct font size for footnotes.

Online books (CMOS 17.142–147)

N. 27Martin Luther, Large Catechism, trans. F. Bente and W. H. T.
Dau (1921; Project Gutenberg, 1999), part 1, First Commandment,
http://www.gutenberg.org/catalog/world/readfile?fk_files=39332&pageno
=6 (accessed July 16, 2005).

B. Luther, Martin. Large Catechism. Translated by F. Bente and W. H. T.
Dau. Project Gutenberg, 1999. http://www.gutenberg.org/catalog/
world/readfile?fk_files=39332&pageno=6. First published in
1921 in Concordia Triglotta by Concordia Publishing House
(accessed July 16, 2006).
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This example is an electronic edition of an older work (no longer protected by copy-
right). The footnote gives 1921 as the original date of publication from which this
online book comes; more complete information is given in the bibliography
(CMOS 17.146 and 17.123).

N. 28Watchman Nee, Incarnation, Inclusion, and Intensification
(Living Stream Ministry, 1997-2005), Chapter Three: An Extract of the
Basic Divine Revelation in the Holy Scriptures, under “I. To Know the
Processed and Consummated Triune God,” http://www.ministrybooks
.org/books.asp?id=166&chapterid=0&sectionid=1&pageid=1 (accessed
June 24, 2005).

B. Nee, Watchman. Incarnation, Inclusion, and Intensification. Living
Stream Ministry, 1997-2005. http://www.ministrybooks.org/
books.asp?id=166&chapterid=0&sectionid= 1&pageid=1
(accessed June 24, 2005).

These online books have no page numbering, so additional information is included
to help pinpoint the location of the material cited in the footnote. This informa-
tion is omitted from the bibliographic entry. In the following example the publish-
ing organization is listed as the author (see CMOS 17.47).

N. 29CIA, “Tanzania: People,” in The World Factbook 2005 (Central
Intelligence Agency) http://www.cia.gov/cia/publications/factbook/geos/
tz.html#People (accessed June 24, 2005).

B. CIA. “Tanzania: People.” In The World Factbook 2005. Washington, DC:
Central Intelligence Agency. http://www.cia.gov/cia/publications/
factbook/geos/tz.html#People (accessed June 24, 2005).

Note that for these examples, no publication place is listed in the footnote and the
abbreviation “n.p.” normally found in citations of print materials is omitted from
the entries. CMOS allows this omission because online publications often do not
have this information (17.146).

News and journal database (CMOS 17.359)

N. 30Paul O. Ingram, “On the Practice of Faith: A Lutheran’s Interior
Dialogue with Buddhism,” Buddhist-Christian Studies 21 (2001): 45,
http://links.jstor.org/sici?sici=0882-0945%282001%2921%3C43
%3AOTPOFA%3E2.0.CO%3B2-%23 (accessed July 16, 2005).

B. Ingram, Paul O. “On the Practice of Faith: A Lutheran’s Interior
Dialogue with Buddhism,” Buddhist-Christian Studies 21 (2001):
43-50, http://links.jstor.org/sici?sici=0882-0945%282001
%2921%3C43%3AOTPOFA%3E2.0.CO%3B2-%23 (accessed July
16, 2005).

This is an example of a service that provides a stable URL to access the item. These
services (such as jstor and lexis-nexis) are usually available through libraries.
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Electronic journals (CMOS 17.180–181)

N. 31Stewart W. Herman, “Turn Abu Ghraib Inside Out?” Journal of
Lutheran Ethics 4/9 (2004): par. 3, http://www.elca.org/scriptlib/dcs/jle/
article.asp?aid=498 (accessed July 16, 2005).

B. Herman, Stewart W. “Turn Abu Ghraib Inside Out?” Journal of Lutheran
Ethics 4/9 (2004): par. 1-17. http://www.elca.org/scriptlib/dcs/jle/
article.asp?aid=498 (accessed July 16, 2005).

This online journal has no page numbers, so the note and bibliography list the
paragraph cited in the note and the total number of paragraphs in the article, re-
spectively. The online version has each paragraph numbered. When there is no avail-
able page or paragraph number, if possible add a descriptive locator, such as subhead
from the article. See CMOS 17.181, and the examples for online books, above.

Reference works online (CMOS 17.239)

N. 32The Catholic Encyclopedia, 1917, s.v. “Thomas Aquinas,
Saint,” http://www.newadvent.org/cathen/14663b.htm (accessed June 23,
2005).

B. The Catholic Encyclopedia, 1917, s.v. “Thomas Aquinas, Saint,”
http://www.newadvent.org/cathen/14663b.htm (accessed June 23,
2005).

N. 33W. A. Wallace, J. A. Weisheipl, and M. F. Johnson, “Thomas
Aquinas, St.,” in New Catholic Encyclopedia (Thomson Gale) http://find
.galegroup.com.ezproxy.stthomas.edu/gvrl/infomark.do?&type=retrieve&
tabID=T001&prodId=GVRL&docId=CX3407711070&eisbn=0-7876
-7694-2&source=gale&userGroupName=stpaulsem&version=1.0
(accessed July 16, 2005). Also available in print version: W. A. Wallace, J.
A. Weisheipl, and M. F. Johnson, “Thomas Aquinas, St.” in New
Catholic Encyclopedia, 2d ed. (Detroit: Gale, 2003), 14:14-15.

B. Wallace, W. A., J. A. Weisheipl, and M. F. Johnson “Thomas Aquinas,
St.” In New Catholic Encyclopedia. Thomson Gale. http://find
.galegroup.com.ezproxy.stthomas.edu/gvrl/infomark.do?&type
=retrieve&tabID=T001&prodId=GVRL&docId=CX3407711070
&eisbn=0-7876-7694-2&source=gale&userGroupName=
stpaulsem&version=1.0 (accessed July 16, 2005). Also available
in print version: Wallace, W. A., J. A. Weisheipl, and M. F.
Johnson, “Thomas Aquinas, St.” In New Catholic Encyclopedia,
2d ed., 14:13-29. Detroit: Gale, 2003.

This online version of New Catholic Encyclopedia is available only through librar-
ies subscribing to it. The print version is listed as a help to the reader. See CMOS
17.144.
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Online newspapers, news services, and other news sites (CMOS 17.198)

N. 34Nolan Zavoral, “Lutherans, Catholics End 30 Years’ Work,”
Minneapolis Star Tribune, November 1, 1999, http://www.startribune
.com/ (accessed July 16, 2005).

B. Zavoral, Nolan. “Lutherans, Catholics End 30 Years’ Work,” Minneapolis
Star Tribune, November 1, 1999. http://www.startribune.com/
(accessed July 16, 2005).

Note that the URL in this example is the main entrance of the newspaper because
the article itself is available from an online archive for a fee.

N. 35Reuters, “Hi-tech Cameras Snap Ancient Bible,” CNN.com,
June 23, 2005, http://edition.cnn.com/2005/TECH/06/23/vision
.monastery.reut/index.html (accessed June 24, 2005).

B. Reuters. “Hi-tech Cameras Snap Ancient Bible,” CNN.com, June 23,
2005. http://edition.cnn.com/2005/TECH/06/23/vision
.monastery.reut/index.html (accessed June 24, 2005).

For this news item, the site is CNN.com but the unsigned article originated from
Reuters news service, which holds the copyright. Therefore, Reuters is listed as the
author. The copyright information is listed at the bottom of the article.

Online magazines are handled in much the same way as their print versions, with
the addition of the URL at the end of the reference. For more information, see
CMOS 17.187.

Informally Published Materials (CMOS 17.234–37)

Because these types of sources are of questionable authority and lack permanence,
they should be used sparingly. When they are used, the guiding principle is to pro-
vide as much information as possible to the reader. The Chicago Manual of Style
recommends the following information: author of the content, title of the page, ti-
tle or owner of the site, URL (17.237).

N. 36Felix Fabri, The Book of the Wanderings of Felix Fabri, “The
Manner in Which Brother Felix Fabri Prepared for His Second Wandering
or Pilgrimage to the Holy Land. Jerusalem, Sion, and Mount Sinai,”
Colorado State University Pueblo, http://chass.colostate-pueblo.edu/
history/seminar/fabri/fabri1a.htm (accessed June 24, 2005). Print version:
The Book of the Wanderings of Felix Fabri (Circa 1480-1483 A.D.), trans.
Aubrey Stewart, 2 vols. (London: Palestine Pilgrims’ Text Society, 1896).

B. Felix Fabri, The Book of the Wanderings of Felix Fabri. Colorado State
University Pueblo. http://chass.colostate-pueblo.edu/history/
seminar/fabri/fabri1a.htm (accessed June 24, 2005). Print version:
The Book of the Wanderings of Felix Fabri (Circa 1480-1483
A.D.). Translated by Aubrey Stewart. 2 vols. London: Palestine
Pilgrims’ Text Society, 1896.
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In this example, the site is the text of a medieval pilgrim’s diary to the Holy Land.
The author is the medieval pilgrim Brother Felix Fabri, and the title of the work is
in italics because it is an actual book title; it is listed next as the title of the page
(which it is at this web address) and is followed by the subheading on the page in
quotation marks; the subheading is included because this is the section of this very
extensive writing that the researcher has cited. The original site (http://chass
.colostate-pueblo.edu/history/seminar/fabri/fabri1.htm) was located by googling
“Brother Felix Fabri.” Finding the owner of the site, Colorado State University in
Pueblo, required hitting the “Home” button at the bottom of this page, and again at
the bottom of the new page that came up. The site is a list of online sources for a
seminar class titled Traveling to Jerusalem. This is the type of research that is nec-
essary to document clearly and accurately as an informally published, online
source.

N. 37David Landry, “What’s Wrong with The Da Vinci Code? One
Biblical Scholar Responds,” University of St. Thomas, http://personal1
.stthomas.edu/dtlandry/davinci/davincicode.htm (accessed July 16, 2005).

B. Landry, David. “What’s Wrong with The Da Vinci Code? One Biblical
Scholar Responds.” University of St. Thomas. http://personal1
.stthomas.edu/dtlandry/davinci/davincicode.htm (accessed July
16, 2005).

This example follows in a straightforward manner the citation elements recom-
mended by CMOS. The author’s name and title are clearly listed on the site. How-
ever, there is no “Home” button on the site, so to confirm that it is the University
of St. Thomas that hosts the site, one must delete the final section of the web ad-
dress on the web page (davinci/davincicode.htm) and then strike the enter key.
David Landry’s personal home page for the University of St. Thomas comes up on
the screen.

The Chicago Manual of Style offers guidance on these additional types of electronic
sources:

• Multimedia (17.270)

• CD-ROMS and DVD ROMS (17.271)

• Public documents (17.356)

• Databases (17.357-58)

>>> UNPUBLISHED MATERIALS — 9.114-15; SEE ALSO 11.36
UNPUBLISHED REPORTS AND PROCEEDINGS

N. 38Donald H. Juel, “The Image of the Servant-Christ in the New
Testament,” Paper presented at Luther-Northwestern Theological
Seminaries, St. Paul, Minnesota, 6 April 1979.

B. Juel, Donald H. “The Image of the Servant-Christ in the New
Testament.” Paper presented at Luther-Northwestern Theological
Seminaries, St. Paul, Minnesota, 6 April 1979.
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>>> SACRED TEXTS

The following “notes” appear in the text without note numerals:

(1 Kgs 10:12) [the preface to the paper indicates that this version or
translation, e.g., the NRSV, is the source of the English biblical quotations
unless otherwise indicated]
(Rom 1:16 NEB)
(1 Cor 13:5 NIV)
(2 Tim 3:6, 8 JB)
(Gen 22:10 LXX, Göttingen)
(Gen 22:10 LXX, Rahlfs)
(Luke 6:1 Nestle-Aland) [if preface indicates this edition is source of Greek
quotations, then “Nestle-Aland” should be dropped]
(b. Sabb. 100a Epstein)

B. The Holy Bible: New Revised Standard Version. New York: Collin’s,
1989.

B. The Holy Bible: New International Version. Grand Rapids, MI:
Zondervan Bible Publishers, 1978.

B. The New English Bible. New York: Oxford University Press, 1961.

B. The Jerusalem Bible. Edited by Alexander Jones. Garden City:
Doubleday, 1966.

B. Septuaginta: Vetus Testamentum. Edited by Academiae Scientiarum
Gottingensis graece. Vol. 1-. Göttingen: Vandenhoeck &
Ruprecht, 1931-.

B. Septuaginta: id est Vetus Testamentum graece duxta LXX interpretes.
Edited by Alfred Rahlfs. 8th ed. 2 vols. Stuttgart:
Württembergische Bibelanstalt for the American Bible Society,
1965.

B. Novum Testamentum graece. Edited by Eberhard Nestle, Erwin Nestle,
Kurt Aland, and others. 27th ed. Stuttgart: Deutsche
Bibelgesellschaft, 1993.

B. The Babylonian Talmud. Edited by I. Epstein. 35 vols. London: Soncino
Press, 1938-52.

>>> GREEK AND LATIN CLASSICAL WORKS AND MEDIEVAL WORKS
–SBL 7.3.2-6

N. 39Boethius, Commentaria in Topica Ciceronis (PL 160.1046c-1048b).

B. Patrologia latina. Edited by J.-P. Migne. 217 vols. Paris, 1844-1864.

N. 40Quintilian, Inst. 5.10.121.
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B. Quintilian. Institutio Oratoria. Loeb Classical Library. 1961. [preferred in
Chicago Manual of Style, 16.55]

N. 41Augustine, The City of God (LCL 6:305). [no subdivision below
book and part levels are used so edition, volume in subset, and page are
given; if quoting from the foreign language, you may use the foreign title,
in this instance, De civ. D. (LCL 6:304)]

B. Augustine. The City of God against the Pagans. 7 vols. Loeb Classical
Library. 1960. [information is from the title page; the no. of vols.
is not necessary but does clarify the volume no. used in the note]

N. 42POxy 1380.135-39. [document no. and lines]

B. Grenfell, Bernard P., and Arthur S. Hunt. Oxyrhynchus Papyri. 1898-19-.

>>> LUTHER’S WRITINGS

See also STANDARDS FOR ABBREVIATION OF LUTHER’S WORKS (pages 20–21). A
reminder: works for which abbreviations are used in the notes must appear in the
LIST OF ABBREVIATIONS.

N. 43Receiving Both Kinds in the Sacrament (1522), in LW 36:240.

B. Luther, Martin. Luther’s Works. Edited by Jaroslav Pelikan and Helmut
T. Lehmann. 56 vols. Philadelphia: Fortress Press; St. Louis:
Concordia Publishing House, 1955-86.

N. 44Von beider Gestalt des Sakraments (1522), in WA 10/2:14.

B. Luther, Martin. D. Martin Luthers Werke. Kritische Gesamtausgabe.
Weimar: Herman Böhlaus Nachfolger, 1883-. [the volume count
is not included since the set has not been finished]

N. 45WA,Br 1: no. 125. [the circumstances of the letter are referred to
in the thesis text; use the letter no. rather than page no. in the citation]

[or]

N. 46Letter to George Spalatin, December 21, 1518 in WA,Br 1: no.
125. [the circumstances of the letter are not referred to in the thesis text]

B. Luther, Martin. D. Martin Luthers Werke. Kritische Gesamtausgabe.
Briefwechsel. 18 vols. Weimar: Hermann Böhlaus Nachfolger,
1930-85.

N. 47Vorrede auf das Neue Testament (1546), in WA,DB 6:9.

B. Luther, Martin. D. Martin Luthers Werke. Kritische Gesamtausgabe. Die
Deutsche Bibel. 12 vols. Weimar: Hermann Böhlaus Nachfolger,
1906-61.
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N. 48WA,TR 4: no. 4317. [use the assigned number from the WA
rather than the page no. in the citation]

B. Luther, Martin. D. Martin Luthers Werke. Kritische Gesamtausgabe.
Tischreden. 6 vols. Weimar: Hermann Böhlaus Nachfolger,
1912-21.

>>> LUTHERAN CONFESSIONAL WRITINGS
[See also STANDARDS FOR THE ABBREVIATION OF LUTHERAN
CONFESSIONAL WRITINGS, pages 21–22.]

N. 49AC,Ger. 15:2, in BC, 48. [Augsburg Confession, Article 15,
marginal number 2]

N. 50SA 3, 15:3, in BC, 326. [Smalcald Articles, Part 3, Article 15,
marginal number 3]

B. The Book of Concord: The Confessions of the Evangelical Lutheran
Church. Edited by Robert Kolb and Timothy J. Wengert.
Minneapolis: Fortress Press, 2000.

N. 51AC,Lat. 20, in BSLK, 77-78. [citations from editions of the
confessional writings other than Kolb and Wengert need include only the
page number]

N. 52AC,Ger. 20, in BSLK, 79-80.

B. Die Bekenntnisschriften der evangelisch-lutherischen Kirche. 10th ed.
Göttingen: Vandenhoeck & Ruprecht, 1986.

N. 53Ap 13:13, in BC, 220-21. [Apology of the Augsburg Confession,
Article 13, marginal number 13]

N. 54FC,Ep 1:8, in BC, 487. [Epitome of the Formula of Concord,
Article 1, marginal number 8]

N. 55FC,SD 5:21, in BC, 585 [Solid Declaration of the Formula of
Concord, Article 5, marginal number 21]

N. 56LC 3, 96, in BC, 453. [Large Catechism, Part 3, marginal
number 96]

N. 57LC Pref. 5 (1528), in BC, 383. [The shorter preface of 1528,
marginal number 5]

N. 58TPP, 67, in BC, 340-41. [Treatise on the Power and Primacy of
the Pope, marginal number 67)
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>>> SUBSEQUENT CITATIONS — 8.84-96

N. 59W. D. Davies, Paul and Rabbinic Judaism: Some Rabbinic
Elements in Pauline Theology (London: S. P. C. K., 1977), 276-84.

N. 60Ibid., 277.

N. 61Ibid., 278.

N. 62Lindars, Apologetic, 85. [a subsequent reference not
immediately following first occurrence]

B. . A Modern Pilgrimage in New Testament Christology.
Philadelphia: Fortress, 1974. [a subsequent title in a bibliography
—this title and the title preceding it were written by “Perrin,
Norman.”]
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INSTITUTIONAL JUDGMENTS
General

1. The preferred type font is Times New Roman 12.

2. Use these margins: 1½" on the left; 1" on the other sides.

3. Print on only one side of a sheet of paper.

4. Use italics rather than underlining.

5. Clarify the use of any abbreviations in the “List of Abbreviations” rather
than in the text, notes, or bibliography.

6. When using an arabic page number, place it at the top right of a page except
for the bottom center location on the first page of a chapter, the bibliogra-
phy, and each appendix.

7. Translate all foreign language citations, words, and phrases following the
citation in the original language.

8. For proper abbreviations of U.S. states, see T 2.13; but use the two-letter
U.S. postal form in footnotes and bibliography: CMOS 15.29.

9. One space after a period that (1) ends a sentence; (2) concludes a section in
a bibliography such as the author, title, and publication information; (3) ab-
breviates a person’s first and middle name, such as: W. D. Davies.

10. Keep paper copies of all electronic sources cited.

Notes and Bibliography

1. Acknowledge the authorship of material used in your paper to avoid
plagiarism. See T 5.2 and the section in the Luther Seminary Student
Handbook entitled “Academic Honesty”: http://www.luthersem.edu/
student_services/handbook/policy/honesty.asp

2. Footnotes are the preferred method of citation. Consecutively number foot-
notes within each chapter.

3. Include in the bibliography citations to all footnoted material.

4. Cite in full the first appearance of a reference in the notes.

5. Do not underline or italicize “Ibid.”

6. Use a shortened form of a citation in subsequent footnotes rather than op.
cit.

7. Italicize titles of whole works but not series. This rule applies to both the
spelled out and abbreviated titles and series (exceptions: modern editions of
biblical versions and translations, for example, NRSV).

8. Translate foreign language designations for volumes and editions of mono-
graphs, serials, and periodicals. Use the English language equivalents—ask
the Luther Seminary Library for guidance.

9. In alphabetizing Medieval and foreign names (e.g., “Thomas Aquinas,” not
“Aquinas, Thomas”; “Rad, Gerhard von” rather than “von Rad, Gerhard”),
students should consult the Luther Seminary library catalog when in doubt
about the proper way to list a name in the bibliography.
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10. Translate foreign language places of publication. Use the English language
equivalents—again, ask the Library for guidance.

11. Cite the first place of publication except where an American place is also
given; then use this latter location.

12. No space after a period for certain abbreviations, such as Ph.D., U.S., n.p.
(no place or no publisher), s.v. (sub verbo). See T 2.5 and 2.26.

13. In footnotes, use a semicolon between multiple citations.

14. Do not give the total pages of a book in the bibliography.

Ph.D. and M.Th. Thesis “Final Copy” Concerns:

1. Use a laser printer to produce the final copies.

2. An abstract of no more than 350 words is submitted as a part of the final
copy of the Ph.D. thesis.

3. After written certification of the final copy by the library representative,
submit the thesis copies in proper order for binding to the Graduate Theo-
logical Education Office. The copies must be on thesis quality paper (100%
cotton, acid-free) and may be the originals or photocopies. For the Ph.D.
thesis, submit three (3) copies; for the M.Th. thesis, submit two (2) copies.
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APPENDIX 
 

SETTING UP YOUR DOCUMENT IN MICROSOFT WORD 
 
 
SETTING UP YOUR CHAPTER 
 
How to number pages so that the first page of a chapter or bibliography is numbered at the 
bottom center and has a 2” top margin but subsequent pages of the chapter are numbered in the 
upper right hand corner with a 1” top margin (directions below are formulated for Microsoft 
Word 2003). 

A. Create a unique first page header or footer for the first page in a document or the first 
page of each section within a document. This first page will have a 2” top margin because 
of how you set up the header, although your actual page top margin will be set at 1”. 

BEST: If you set up your document when you begin, each subsequent section you begin 
should include the settings you have specified. This requires that you set a section break at 
the end of each chapter (Choose Insert from the Menu Bar, choose Breaks..., and under 
Section break types choose Next page). 
OR: If you need to add this formatting after you are finished with your document and 
sections have already been set up, either select multiple sections to make the change or click 
in each section separately to make the change section by section. 

TWO WAYS  to set up the formatting for a different first page: 

From the View menu                                           OR From the File menu 
  Click Header and Footer      Click Page Setup 
  On the Header and Footer toolbar  
     click the Page Setup icon   

 

  Click the Layout tab   Click the Layout tab 
  Select the Different first page 
     check box, and then click OK 

  Select the Different first page 
     check box, and then click OK 

Be sure you can see the header and footer areas in your document. 

From the View menu click Header and Footer    

Be sure you are on the first page to complete the formatting for your page numbering.  

You may need to click Show Previous  or Show Next   on the Header and Footer 
toolbar to move into the First Page Header area or First Page Footer area. 

B. Create the header and footer for the first page of the document or section.  
In this example, we want the header to create a 2” top margin. Place your cursor within the 
top header and go to Format and then Paragraph. Under Spacing choose under Line 
Spacing: Exactly and make At: 112 pt. Click OK. 
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To include a footer with centered page number place your cursor in the footer area. 
It should say “First Page Footer” just above the boxed in footer area 

Type page number and format to be centered on the page 

Type your first page of text. When your text continues to the second page: 

C. Create the header and footer for subsequent pages of the document or section.  
To move to the header or footer for the rest of the document or section, click Show Next  on the 
Header and Footer toolbar. Then create the header and footer you need for subsequent pages. In 
the header, specify a page number aligned to the right and use Format, Paragraph as described 
above to set the Line Spacing exactly at 24 pt. 

 
SOME TIPS REGARDING FOOTNOTES 
 
A. How to delete a footnote: 

 

Delete the note reference mark in the body of the 
document, not at the bottom of the document. 

 

 

 
B. Move a footnote from one location in the document to another: 

 

Click and drag the note reference mark in the body of 
the document from one place to another. 

 

 

 
C. Avoiding the problem of footnotes appearing on the next page  
      (instead of the page where the footnote reference mark appears): 

Move text in the body of the document to the next page 
Use an endnote instead for lengthy comments (if use of both footnotes and endnotes is 
permitted) 
Create a footnote continuation notice to specify the footnote continues on another page 



 

40 

D. Modifying Footnote Text Style  

Place your cursor in the footnote text 

On the Format menu, click Style. 

In the styles list, Footnote Text should be visible 

 
As you move your cursor over that area 
    a dropdown menu arrow will appear on the right side. 
Click the dropdown menu arrow and select Modify 

 

 

 

 

 

 

 

 

 

Click on Format >>  
A dropdown menu will appear, including the normal formatting selections: 
       Font…  Paragraph…  Tabs…  Border…  etc. 

Change the formatting to specify Paragraph Indentation as Left, .5”, First Line, 
and Spacing, After: 12 pt, then click OK. 

 
 
E.  Footnote continuation notice:  

On the View menu, click Normal.  
Again on the View menu, click Footnotes. (one footnote must already be entered.) 

If your document contains both footnotes and endnotes, a message appears.  
Click View footnote area or View endnote area, and then click OK. 

In the footnote pane, click Footnote Continuation Notice or Endnote Continuation 
Notice. 
In the note pane, type the text for the notice, for 
example, Footnotes continued on the next page. 

 
 
You must click Print Layout on the 
View menu to see the continuation 
notice as it will appear in the printed 
document. 
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SETTING UP YOUR BIBLIOGRAPHY 
 
Set up your margins and page numbering as you have done for your chapters. 
 
For bibliography entries formatting, click on Format, then Paragraph. Under Indentation look 
for the box marked Special and set to Hanging. Close the box. 
Begin typing a bibliographic entry. The second and subsequent lines will automatically indent 
when the lines wrap. 
If you try to set up your bibliography by manually tabbing in the second and subsequent lines, 
you will have formatting problems whenever you have to edit an entry. 
 
 
SETTING UP YOUR TABLE OF CONTENTS  
 
On the Format menu, click Tabs. If the Tab Stop Position list at the left of the dialogue box 
shows any existing tab settings, click the Clear All button. Set a 0.3" left tab by typing the 
measurement in the box above the Tab Stop Position list and clicking Left under Alignment, 
None under Leader, and the Set button. Proceed in the same way to set a 0.6" left tab. Now 
enter a 6" tab and click Right under Alignment and 2 under Leader. 
The tabs are now set. To list a chapter in the Table of Contents, type the chapter number, [Tab], 
the chapter name, [Tab], and the appropriate page number. 
 
 
ADDITIONAL RESOURCES 
 
Microsoft Office Word Help: 
Often, one can find the help you need from the built in help topics provided with Word. 
From the Help menu click “Microsoft Office Word Help” 
Type in the topic you need help with in the “Search for”and press enter 
The help function will bring up a series of items that make reference to your topic.  
 
The following links were accessed on October 6, 2005: 
Microsoft provides online training for setting up headers and footers. This tutorial includes sound, 
so you need to be seated at a computer with speakers or a headset. 
http://office.microsoft.com/training/training.aspx?AssetID=RC010216611033  
 
Creating a macro to meet specific requirements for document settings.  These instructions are set 
up for court requirements, but could be easily used for course settings as well. 
http://office.microsoft.com/en-us/assistance/HA010744091033.aspx 
 
Demo: Delete the first-page header/footer or make them unique. 
http://office.microsoft.com/en-us/assistance/HA011542131033.aspx 
 
You will find other helpful demos and tutorials at the Microsoft web site. 
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